Appendix 5 - Downloading Individual fields from WinIBW

This guide will walk you through how to download a whole record, a
specific field or a set of fields from the results of a search of the
WinIBW system, in either the Marc21 or Pica encodings. It will then
explain how to import this data into Microsoft Excel to produce a
spreadsheet on which further work can then be done, without the
need to copy out large amounts of data manually.

Searching WinIBW

Before you download anything, you need something to download.
Use the WinIBW interface to do whatever search you need to
download the results from. Further information on searching can be
found in the British Library ISNI Guide in Chapter 2 and Appendix 3.

As an example, I am searching for all records that have at least two
sources, one of which is Scholar Universe:

Search | Histary Tndlesx Heln

|fin src:11? SCHU?

Make a note of the set of your search; you can find this by
navigating to the History tab at the bottom of the screen. The set of
my search is S1:

ADI REC *;MTC * SPL *;¥OB *; ST, CC ; CR %




Setting your download location

Before telling WIinIBW to download anything, you must specify
where it will be downloaded to. To do this, click the Options menu
at the top of the screen, and choose Preferences:

B Win1BW 3.5 - [CBS,/ISNL/ISNI, user=JASPER JACKSON (jasper), ISNI {0002 1]
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This will bring up the Preferences window. Ensure that the top tab,
General 1, is selected on the left-hand side. The window you now
see contains the options for specifying download location. Under File
Location, ensure that the upper selection box says ‘Download’. The
Location box may contain text; this will be a previous or default
(and quite hard to find!) download location. You will enter your own
download location shortly. For now, excepting the Location box, the
window should look like this:
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The WinIBW download function appends the download selection to
an existing text file; if the file already contains data, the WinIBW
download will appear after this information.



There are two ways to select a file to download into. You can either
click Browse, and select a file that already exists on your system or
you can click Save As to create a new file in a location of your
choosing. Here, I choose Save As to create the new text document
“"Download 1 26-11-12.txt". I have chosen to create the download
file in the My Documents folder on my computer:

Desktop 'ﬂ My Pictures
| Outlionk,

‘ ) Personal docs

My Documents

{Save As...

My Computer

File narme: IannInad 1261112 j Save

|_save_|
Cancel |
7

Save as tupe: ITe:-tt Filez

WinIBW will only download into a text file such as “Test
Download 1.txt”, NOT a Microsoft Word file. Even if you do find
another format that you can download into, other formats are
harder to export into Microsoft Excel.

After selecting your download location, you should see the
Preferences window looking something like this:

File Location

Fonts and Colors
File Type: I Download j
% Location: I file: { i fwzk 3-bsp2 fusers) 18 1ACK SO Download ¥ 2015 2026-11-12. bxt
Messages I~ Print Erowse, ..

Now click Ok, and you are ready to download! Don’t forget to
change the location you are downloading to between downloads if
you don’t want to attach your separate downloads together!



The Download Command
The general form of the download command is:
Dow <set> <records> <format>

<set> refers to the set number of the search you want to download
from. In the example given here, that is S1.

<records> refers to the numbered results in the search; if you
wanted to download everything from the second record to the tenth
record, this would be 2-10.

<format> refers to the format in which the records will be
downloaded; Marc21, Pica or Key formats are available. Format is
also where you specify which fields you would like to
download. You can download a subset of fields in either Marc21 or
Pica encoding. The different format options are shown in the table
below:

Command | Explanation

m21 Download whole records in Marc21 format

km21:X:Y | Download fields X and Y of records in Mark21 format.

P Download whole records in Pica format
kp:X:Y Download fields X and Y of records in Pica format.
key Download in WinIBW Key format

Note the k in the cases where individual fields are desired. It is
possible to download any number of individual fields in this way, not
just one or two; downloaded fields are separated by a semicolon. If
there are multiple copies of a field (i.e. several 700 fields in Marc21
encoding corresponding to names from different sources) these will
also be separated by a semicolon.

These commands are case-sensitive! Downloading may not
work correctly if you use, for example, M21, or 77a (should be m21,
77A).

Typical fields you may want to download include, in Marc21 (and
Pica) encoding:

PPN: 000 (003@)




Personal Name: 700 (028C)
Potential matches: 77A (038L)

Other fields can be seen within the records and in Appendix 1 of the
British Library ISNI Guide; please note they must be entered
exactly as they appear within the record.

So, to download the PPN and Personal Name fields from records 2-
10 found by my search in Marc21 format, I would type:

Histary Inces Delete Insert L

dow S1 2-10 km21:000:700

When you press enter, the download will occur and the message
“End of download will appear at the top left of your screen:

T=T% AW W7 VW[l T[]

(i) End of download,

W ieni

If this doesn’t happen, something has gone wrong!



Importing downloads into Excel

Now you have downloaded the records, you can use My Computer
or Windows Explorer to navigate to the location you picked to save
it in earlier and open the file you created. It should look something
like the screenshot below (unless your data is very different):
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You can see the record numbers on the far left, followed by the field
name and its content, then after a semicolon, the next field name
and its content, and so on. Note that the 700 fields from different
sources appear as separate fields here.

Now, open Microsoft Excel (In this guide I will describe the
procedure using Excel 2003; other versions may differ slightly but
the essentials are the same).

In Excel, go to File > Open, then in the window that opens, choose
‘All Files (*.*)’ from the drop-down menu at the bottom:

My Computer

I. !g File name: j Open |~

My Metwork,
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Then navigate to your results text file and click Open.

This will bring up a new window:



Text Import Wizard - Step 1 of 3

The Text \Wizard has determined that your data is Fixed Width,
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This is the Text Import Wizard, which will convert text files into a
spreadsheet-compatible form. At the top are several options, and at
the bottom is a preview of the file you have selected to import
(useful to check that you picked the right one!).

Make sure that the Delimited radio button is selected in the Original
data type section at the top of the window. Look at the preview of
your file in the bottom half, and if the data you want to import does
not start on the first row, change the Start import at row box in the
middle of the window to select the first row of data you wish to
import. You can ignore the File Origin box, as the correct type
should be picked for you by default (this may vary based on your
system). Ensure that your window matches the example above
(though you may be starting import on a different row or have a
different file origin), then click Next >.

This page (step 2 of 3) lets you tell Excel how the different columns
in your spreadsheet will be separated. In the Delimiters box at the
upper left of the window, ensure that the Comma, Semicolon and
Other: boxes are selected, and enter a dollar sign ($) in the box to
the right of Other:
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This will result in a series of vertical lines appearing in the Data
preview in the bottom half of the window, separating your data into
columns. You can scroll down and right to see more of how your
data is separated. Make sure that Treat consecutive delimiters as

one is selected, and then press Next >.

Choosing different delimiter options will change how your
data is split up. Look at the preview, and if data is split in a
way that you will not find useful, change the choice of
delimiters to suit your needs.

This window (step 3 of 3) allows you to select which columns are
imported and choose the format of each column. It is important to
make sure that any column containing ISNIs, PPNs, etc. is set to a
data format of Text by selecting the column in the bottom half of
the window and then choosing a format in the Column data format
section in the upper right. If you don’t do this, any zeros at the
beginning of PPNs, ISNIs or any other numerical data will be
deleted, making it very hard to search for them in WinIBW.

It is often a good idea to select all the columns (by clicking the left-
most column, scrolling all the way right, and then clicking the right-
most column while holding the Shift key on the keyboard) and then
change them all to text-format, as it is the most useful.

If there are any columns that you do not want to use or import, you
can choose not to include them at this stage by selecting them in
the bottom half of the window and then choosing the Do not import
column (skip) radio button towards the top right of the window.




Text Import Wizard - Step 3 of 3
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Important note: There are often different numbers of
delimiters, and therefore different numbers of columns, in
each row of your data. This can mean that a column containing
primarily data of one type can include data that would usually be in
another column - see Row 6, Column 5 in the screenshot
above. Therefore, be very careful, when choosing not to include
columns, that you do not need the data they contain lower down
the spreadsheet. You can always delete unnecessary columns or
cells later if you need to! When you have checked that your import
is correct, click Finish.

You will now see all of your data in the spreadsheet as in the
screenshot below. Click on the small square in the top left hand
corner between the Row and Column headings to select every cell,
and then double-click on one of the lines between the column
headings to change their width to fit the content automatically:

@_j Eile  Edit Wiew Insert  Format  Tools  Data  Window  Help
NEHdOdQ @ aBa-9-2z-4l@e [ 10 -|B I U ==
C11 - &
A | B | ¢ | D | E | F | & | H | I
|1 | 2000 372268776x 700 1# aAllan b 2IMAM | 700 ## ahAllan Stuart d1962-...
| 2 | 3000372280641 700 1# aO'Brien | Thomas . 25CHU 700 1# aO'Brien | Thomas V. | 2BOWKER
|3 | 400037211346 700 1# aCarlson | Toby M. 25CHU 700 1# aCarlson | Toby N. 2B0WWKER
|4 | 5000372112536 | 700 1# aWelling | Sarah Mewcomb 25CHU 700 1# aWelling | Sarah M. 2BOWWKER
|5 | 600037134253« 700 1# aClark Russell . clr 25CHU 700 1#  aCLARK ROEIM
|6 | 7000371161843 | 700 1# aSpurr Johin 25CHU | 700 1# aSpurr Johin doa. 2. H 200 Jhe - 1. H.
| ¥ | 8000371083702 | 700 1# aSacerdoti| Earl D. 25CHU | 700 1# aSacerdoti | Earl D. 3public
|8 | 5000370120584 700 1# aAmnold Michael 25CHU | 700 1# afrnold Michael d1564-
|9 | 10000 365370953 | 700 1# aMarti Felix 25CHU | 700 1# aMarti Felix 3public
10
11] —
112
113 |
14




This is also a good opportunity to delete any columns you do not
need; typically many of the columns on the right hand side will
include only a few cells of useless information. To do this, first
select the columns to delete by clicking on their headings. Then
right-click on any heading, and chose Delete from the context menu
that appears.

£ Microsoft Excel - Download 1 26-11-12.txt

E‘ﬂ File Edit  Wiew Insert  Formak  Tools  Data  Window  Help

DEHS & Q&85 @, - E -5 @ E.ﬁ.rial STV : T
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| 1| 200037225776 [ 700 1# aAllan = 2MAM 700 &2 a4 4 Cut 1962
| 2 | 3000372250641 | F00 1# aO'Brien Thormas . 25CHU 700 1# a 23 Copy 2BV
| 3 | 400037211346 | 700 1# aCarlson | Toby M. 25CHU FOO1# ad = 2BOWYIT
| 4 | 5000372112536 | 700 1# aWelling Sarah Mewcomb 25CHU 700 1# a & Paste 2BOWYIE
| 5 | B0O0037134285x | 700 1% aClark Russell G. cr 25CHU 7 Paste Special. .. ROBIN
| B | 7000371161843 | 700 1% a=purr Jdohn Z2ECHU 700 14 af — dca 2. H
| # | 8000371083702 | FO00 1# aSacerdoti | Earl D. 25CHU 700 1# af - Spublic
| B | 9000370120884 | ¥00 1# aAmald Michael 25CHU 700 1# a.1| Delete |j'|954—
| 9 | 10000 389370353 | 700 1# atdarti Felix 25CHU 700 1# a Clear Coptents Spublic
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N.B. To select more than one column at once, select the first
column, and then select subsequent columns while holding the Ctrl
key on the keyboard; to select a range select the other end of the
range of columns you want while holding Shift.

10



Tidying up the data

You should now see the remaining columns arranged as below. This
is the data you need, but it still needs cleaning up; columns A and B
have information we do not need at the beginning of each cell:

= ¥ =

—A N6 [ ¢ [ o [ E [ F [ 6 [ H | I |
12 DD@?QB??Wn s

| 2 | J000 372250641 TalBrien | Thomas .

| 3 | 400037211346% aCarlson | Toby M.

| 4 | 5000372112536 aWelling | Sarah MNewcomb

| 5 | B00037134283%  aClark Russell G.

| B | 7000371161843 |aSpurr John

| 7 | 8000371083702 |aSacerdoti| Earl 0.

| & | 9000370120884 aAmald Michael

| © | 10000 365370953 aharti Felix

—
[

ke
[

—

You may want to change Al from * 2 000 37228776X" to
“37228776X”, which can be easily copied and pasted into WinIBW.
To accomplish this, you can use a pair of Excel functions. The
=RIGHT(<source>,<number>) function displays a specified number
of characters from the right-hand side of the selected source cell.
Looking at cell A1, you can see that the PPN you wish to display is 9
digits long. Therefore, I will enter =RIGHT(A1,9) in cell E1, as
below:

il | s IEE] T - [, v 51 (7] B BT 0]
SLM v X J & =RIGHT(A1 9)
A B | 8 | D E | F | G |
1 2000 37228776X lafllan = =RIGHT{A1 )
| 2 | 3000372280641 aCBrien Thomas % ' [ RIGHT{text, [num_chars]) |
3 | 4000 37211346% aCarlson

Toby M.
Loy NS

| Pl o | T o I s B P | o LRI | L bl s ey

To remove the “a” from the beginning of cells in column B, you can
use =RIGHT() again, but you need to know how many digits you
need. Here you want one character less than the total number of
characters in the cell. You can use =LEN() to find out the ‘length’ of

a piece of data in a cell, so in column FE I will enter
=RIGHT(B1,LEN(B1)-1):

- ,_'ﬂ EF:I} == '\-El' L g - P * 'g.l B L ll=L T

UM v X o A& =RIGHT{E1 LENET-1)

A B C | b | E F | 6 | H

11 | 200037226776 [aAllan 5 372287 764=RIGHT(E1 LEN(E1-1)
12 | 3000372280641 a0Brien Thomas . [ RIGHT{text, [num_chars]) |
3 4 000 37211346 1aCarlzon Toby M

You can see that this has resulted in the PPN and the Surname,
without additional characters, being displayed next to each other
further across the spreadsheet. I will also enter =C1 into the cell G1
to make a copy of column C next to my ‘cleaned up’ data:
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FSRREEF =Y = NN W] 7] Airial I =T B ]
fe =C1
| B8 | C 0D [ E [ F G H |
adllan 5 372287 7Ex Allan LS 1

all'Brien Thomas .

N A P Tl Bl

N.B. the =LEFT() command works in exactly the same way as
the =RIGHT() command for removing characters from the
end of a cell, if necessary.

Once I have these cells filled, I can select all 3 new cells and,
clicking and holding down the mouse button on the bottom-right
corner of my selection, drag down the spreadsheet to copy
equivalent values in for every cell in my data set:

= - A =RIGHT{A1,9)
A | B | & | D E | F | 6 H |

|1 | 200037228776 |asllan ] 37 22687 7ExAllan =
|2 | 3000372280641 |a0'Brien | Thomas . 372280641 0'Brien  Thamas
|3 | 4000372113465 aCarlson | Taoby M. 37211346 Carlson Toby M.
4 | 5000372112536 |aWelling | Sarah Mewcomb 372112636 Welling Sarah Megcomb
15 | 600037134285% aClark Ruszell G. 37134283 Clark FRussell 3
B | 7000371161843 aSpurr John 371161842 Spurr Jahn
¥ | ©000371083702 aSacerdoti| Earl D 37108370z Sacerdoti  Earl D.
|18 | 9000370120884 aAmald Michael 370120854 Arnold Michael
|9 | 10000 369370953 |aMari Felix 36937095Z Marti Felix
0] A
11

Now you can hide (but not delete) your original columns by
highlighting the column headings (here, I highlighted A,B,C, and D)
and then right-clicking and selecting Hide from the context menu:

1 | 20003722687 76x
2 | 3000 372280541

3 | 4000372113465
4 | 5000 372112536
5 | 6000 37134283%
B | 7000371161843
/| 8000371055702
8 | 9000 3701205884
8 | 10 000 369370953
10

1

12

13

14

alllan
al'Brien
aCarlson
av'elling
aClark
a=purr
aSacerdoti
asrnold
abdarti

E | F | {

= & cut B Allan S
Thomas . 23 copy 41 0'Brien Thaor
Toby M. _: = Ex Carlson | Toby
Sarah Mewcor = Paste GEYYelling | Sara
Russell . Paste Special. .. e Clark Fus
John 4= Spurr John
Earl D. Insert [ZSacerdoti | Earl
fdichael Delete B4 Arnold ich
Feliz Clear Cotents E2Mari Feli

1 Format Cells. ..

Colurnn Width, ..
| Hide
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After inserting a new row for column titles I am left with the
spreadsheet below, ready for me to enter data. Now use File >
Save As to save in an Excel file format such as *.xls or *.xlsx!

E | F [ G [ H [ | [ J [ K [ L [ [} [ I [ [4] [ P [ Q
1 |PPN ISurname Forenames
2 (e Al 5 savens 2l x|
|3 |372250641 O'Brien Thomas . Save in: IQ Guide - WinlBY downloads j @-3Q X oy - Tooks~
|4 37211346 Carlson | Toby M
15 |372112536 Wielling Sarah Newcomb J
1B |37134283% Clark Russell G My Recert
|7 1371161543 Spurr John Documents
|8 |371083702 Sacerdoti | Earl D
|9 |370120854 Amald Michael 9
10 |369370953 hdarti Felix
1| Deskiop
12| :
3 T
i [y DEC-LTn{ents
5 |
16 -
i 58
8
E My Computer
3 y
[21 D File narne: Spreadsheet to sample data,xls - Save
b7 | My Metwork, =
f Places EE VR icynsnft Office Excel Workbook (=) Cancel y

F
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